Preparing a paper using Microsoft Word for publication in
Towards a Sustainable Built Environment: SBE16 Malta
Conference

J Abc
University of ABC

E-mail: abc@abc.org

Abstract. All articles must contain an abstract. The abstract text should be formatted using 10 point Times (or Times Roman, or Times New Roman) and indented 25 mm from the left margin. Leave 10 mm space after the abstract before you begin the main text of your article. The text of your article should start on the same page as the abstract. The abstract follows the addresses and should give readers concise information about the content of the article and indicate the main results obtained and conclusions drawn. As the abstract is not part of the text it should be complete in itself; no table numbers, figure numbers, references or displayed mathematical expressions should be included. It should be suitable for direct inclusion in abstracting services and should not normally exceed 200 words. The abstract should generally be restricted to a single paragraph. Since contemporary information-retrieval systems rely heavily on the content of titles and abstracts to identify relevant articles in literature searches, great care should be taken in constructing both.

1. Introduction
These guidelines, written in the style of a submission to SBE16 Malta Conference, discuss how to prepare your paper using Microsoft Word. In addition to the usual guidance on style/formatting, there are notes and links to assist in using some of Word’s features such as inserting graphics, formatting equations and so forth.

Page layout (headers, footers, page numbers and margins)
If you don’t wish to use the Word template provided, please set the margins of your Word document as follows.

- From the File menu select the Page Setup … option to display the Page Setup dialog box.
- Select the paper size you want to use (US Letter or A4).
- Depending on the paper size you use, adjust the margin settings to those shown in table 1.

1 To whom any correspondence should be addressed.
Table 1. Setting Word’s margins for A4 and US Letter paper.

<table>
<thead>
<tr>
<th>Margin</th>
<th>A4</th>
<th>US Letter</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>4.0 cm</td>
<td>3.1 cm</td>
</tr>
<tr>
<td>Bottom</td>
<td>2.7 cm</td>
<td>1.8 cm</td>
</tr>
<tr>
<td>Left</td>
<td>2.5 cm</td>
<td>2.8 cm</td>
</tr>
<tr>
<td>Right</td>
<td>2.5 cm</td>
<td>2.8 cm</td>
</tr>
<tr>
<td>Gutter</td>
<td>0 cm</td>
<td>0 cm</td>
</tr>
<tr>
<td>Header</td>
<td>0 cm</td>
<td>0 cm</td>
</tr>
<tr>
<td>Footer</td>
<td>0 cm</td>
<td>0 cm</td>
</tr>
</tbody>
</table>

*These must be set to 0 cm. In addition, please make sure the Mirror Margins option is not selected.

1.1.1. Headers and footers

It is vital that you **do not add any headers, footers or page numbers to your paper**; (this is why the Header and Footer margins are set to 0 cm in table 1).

2. Formatting the title, authors and affiliations

In this section we discuss how to format the title, authors and affiliations. Please follow these instructions as carefully as possible so all articles within a conference have the same style to the title page. This paragraph follows a section title so it should not be indented.

2.1. Formatting the title

The title is set 17 point Times Bold, flush left, unjustified. The first letter of the title should be capitalized with the rest in lower case. It should not be indented, as shown above. Leave 28 mm of space above the title and 10 mm after the title. The easiest way to do this is to select **Format → Paragraph** and set the ‘Spacing Before’ value to 28 mm and ‘Spacing After’ to 10 mm.

2.2. Formatting author names

The list of authors should be indented 25 mm to match the abstract. The style for the names is initials then surname, with a comma after all but the last two names, which are separated by ‘and’. Initials should not have full stops—for example **A J Smith** and **not A. J. Smith**. First names in full may be used if desired. If an author has additional information to appear as a footnote, such as a permanent address or to indicate that they are the corresponding author, the footnote should be entered after the surname. However, before adding any footnotes please read appendix A ‘Inserting footnotes with Microsoft Word’ for detailed notes and a complete example.

2.3. Formatting author affiliations

Please ensure that affiliations are as full and complete as possible and include the country. The addresses of the authors’ affiliations follow the list of authors and should also be indented 25 mm to match the abstract. If the authors are at different addresses, numbered superscripts should be used after each surname to reference an author to his/her address. The numbered superscripts should **not** be inserted using Word’s footnote command because this will place the reference in the wrong place—at the bottom of the page (or end of the document) rather than next to the address. Ensure that any numbered superscripts used to link author names and addresses start at 1 and continue on to the
number of affiliations. Do not add any footnotes until all the author names are linked to the addresses. For example, to format

A Smith\textsuperscript{1,3}, J E Black\textsuperscript{1,4} and S T Mood\textsuperscript{2,5}

where there are three addresses, you should insert numbered superscripts 1, 2 and 3 to link surnames to addresses and then insert footnotes 4 and 5. Note that the first footnote in the main text will now be number 6.

2.3.1. Inserting superscripts to link names and addresses.

- Type the appropriate superscript value just after the surname and just before the address:

A Smith\textsuperscript{2}  
2 Institute of Papers, Ding Dong Street, Rabat RBT 1234, Malta

- Select each number in turn (here ‘2’) and do the following:
  - Choose Format $\rightarrow$ Font to display Word’s ‘Font’ dialog box.
  - Select ‘Superscript’ under the ‘Effects’ options.
  - Click OK to apply the text formatting. You should see this:

A Smith\textsuperscript{2}  
2 Institute of Papers, Ding Dong Street, Rabat RBT 1234, Malta

Repeat the procedure for all superscripted numbers. Please make sure that any footnotes within the main text of your article continue on from any superscripted numbers used to link author names and affiliations. For example, if you referred to two addresses the first proper footnote in the text would be footnote 3.

3. Formatting the text

The text of your paper should be formatted as follows:

- 11 point ‘Times’ or ‘Times Roman’ or ‘Times New Roman’ depending on the fonts installed on your computer.
- The text should be set to single line spacing.
- Paragraphs should be justified.
- The first paragraph after a section or subsection should not be indented; subsequent paragraphs should be indented by 5 mm.
4. Sections, subsections and subsubsections
The use of sections to divide the text of the paper is optional and left as a decision for the author. Where the author wishes to divide the paper into sections the formatting shown in table 2 should be used.

4.1. Style and spacing

<table>
<thead>
<tr>
<th>Table 2. Formatting sections, subsections and subsubsections.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
</tr>
<tr>
<td>------</td>
</tr>
<tr>
<td><strong>Section</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Subsection</strong></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Subsubsection</strong></td>
</tr>
</tbody>
</table>

4.2. Numbering
Sections should be numbered as follows:
- sections should be numbered 1, 2, 3, etc
- subsections should be numbered 2.1, 2.2, 2.3, etc
- subsubsections should be numbered 2.3.1, 2.3.2, etc

with a dot following the number and then separated by a single space.

4.2.1. This is an example of a subsubsection. Note that the text for subsubsection headings should be run into the text of the first paragraph.

5. Footnotes
Footnotes should be avoided whenever possible. If required they should be used only for brief notes that do not fit conveniently into the text. Please read appendix A ‘Inserting footnotes with Microsoft Word’ for guidelines on working with Word’s footnote facility.

6. Figures
Each figure should have a brief caption describing it and, if necessary, a key to interpret the various lines and symbols on the figure.

6.1. Space considerations
Authors should try to make economical use of the space on the page; for example:
- avoid excessively large white space borders around your graphics;
- try to design illustrations that make good use of the available space—avoid unnecessarily large amounts of white space within the graphic;

6.2. Text in figures
Wherever possible try to ensure that the size of the text in your figures (apart from superscripts/subscripts) is approximately the same size as the main text (11 points).
6.3. Line thickness
In general, try to avoid extremely fine lines (often called ‘hairline’ thickness) because such lines often do not reproduce well when printed out — your diagrams may lose vital information when downloaded and printed by other researchers. Try to ensure that lines are no thinner than 0.25 pt. Note that some illustrations may reduce line thickness when the graphic is imported and reduced in size (scaled down) inside Microsoft Word.

6.4. Colour illustrations
You are free to use colour illustrations for the online version of Towards a Sustainable Built Environment: SBE16 Malta Conference but any print version will only be printed in black and white unless special arrangements have been made with your conference organizer for colour printing. Please check with the conference organizer whether or not this is the case. If any print version will be black and white only, you should check your figure captions carefully and remove any reference to colour in the illustration and text. In addition, some colour figures will degrade or suffer loss of information when converted to black and white and this should be taken into account when preparing them.

6.5. Positioning figures
Individual figures should normally be centred but place two figures side-by-side if they will fit comfortably like this as it saves space. Place the figure as close as possible after the point where it is first referenced in the text. If there are a large number of figures it might be necessary to place some before their text citation. Figures should never appear within or after the reference list.

6.6. Figure captions/numbering
Captions should be below the figure and separated from it by a distance of 6 points — although to save space it is acceptable to put the caption next to the figure. Figures should be numbered sequentially through the text — ‘Figure 1’, ‘Figure 2’ and so forth and should be referenced in the text as ‘figure 1’, ‘figure 2’, . . . and not ‘fig. 1’, ‘fig. 2’, . . .

For captions not placed at the side of the figure, captions should be set to the width of the figure for wider figures, centred across the width of the figure, or, for narrow figures with wide captions, slightly extended beyond the width of the figure. The caption should finish with a full stop (period).

6.6.1. How to format figures and captions. One of the easiest ways to format a figure and the corresponding caption is to place the figure and caption in a table containing one column and two rows; place the graphic in the top row and the caption in the bottom row. To format the figure/table combination, you can adjust the width of the table, centre the table and adjust the width of the rows to give the appropriate layout.

6.6.2. Examples. The following examples show how to format a number of different figure/caption combinations. Note that the table borders are shown as broken lines for guidance only; they should not, of course, be shown in your actual paper.

- Figure with a short (narrow) caption. Centre the table and centre the caption and figure inside each table cell.
6.6.3. Side-by-side figures. Where possible, try to place figures side-by-side to reduce the amount of space used. Use a table to do this. For example, to put two figures side-by-side create a table with three columns and two rows. Make the middle column narrow to provide some space between the graphics, as shown below. Note that the table borders are shown as broken lines for guidance only; they should not, of course, be shown in your actual paper.
6.7. Figures in Parts
If a figure has parts these should be labelled as (a), (b), (c) etc on the actual figure. Parts should not have separate captions.

7. Tables
Note that as a general principle, for large tables font sizes can be reduced to make the table fit on a page or fit to the width of the text.

7.1. Positioning tables
Tables should be centred unless they occupy the full width of the text.

7.2. Tables in Parts
If a table is divided into parts these should be labelled (a), (b), (c) etc but there should only be one caption for the whole table, not separate ones for each part.

7.3. Table captions/numbering
Tables should be numbered sequentially throughout the text and referred to in the text by number (table 1, not tab. 1 etc). Captions should be placed at the top of the table and should have a full stop (period) at the end. Except for very narrow tables with a wide caption (see examples below) the caption should be the same width as the table. Note, to set captions to be the same width as the table, one convenient method is to place the caption inside a row at the top of the table and merge (combine) the cells together so that you have a single table cell the width of the table (select the row to contain the caption and do Table → Merge Cells).

7.4. Rules in tables
Tables should have only horizontal rules and no vertical ones. Generally, only three rules should be used: one at the top of the table, one at the bottom, and one to separate the entries from the column headings. Table rules should be 0.5 points wide.
7.5. Examples
Because tables can take many forms, it is difficult to provide detailed guidelines; however, the following examples demonstrate our preferred styles.

7.5.1. A simple table. The following example is a simple, narrow table. Here we extend the caption text outside the width of the table.

**Table 3.** A simple table. Place the caption above the table. Here the caption is wider than the table so we extend it slightly outside the width of the table. Justify the text. Leave 6 pt of space between the caption and the top of the table.

<table>
<thead>
<tr>
<th>Distance (m)</th>
<th>Velocity (ms$^{-1}$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>100</td>
<td>23.56</td>
</tr>
<tr>
<td>150</td>
<td>34.64</td>
</tr>
<tr>
<td>200</td>
<td>23.76</td>
</tr>
<tr>
<td>250</td>
<td>27.9</td>
</tr>
</tbody>
</table>

7.5.2. A more complex table. The following is a slightly more complex table with a caption that is narrower than the table. Centre the caption across the width of the table. If it is difficult to make a table fit the page, use a smaller font. Headings should normally be in Roman (i.e., not bold or italic) type, have an initial capital and normally align left (but centred sometimes looks better); it is up to the author to choose a layout that is most useful to the reader. Columns of numbers normally align on the decimal point and it is quite possible to do this in Word using a “decimal tab”; however we will not describe this here—details may be found in Word’s help facility.

**Table 4.** A slightly more complex table with a narrow caption.

<table>
<thead>
<tr>
<th>Wake Chi Sq. $(N=15, df=1)$</th>
<th>$p$</th>
<th>Stage 1 Chi Sq. $(N=15, df=1)$</th>
<th>$p$</th>
<th>Stage 2 Chi Sq. $(N=15, df=1)$</th>
<th>$p$</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3</td>
<td>1.143</td>
<td>0.285</td>
<td>0.286</td>
<td>0.593</td>
<td>0.286</td>
</tr>
<tr>
<td>Fz</td>
<td>1.143</td>
<td>0.285</td>
<td>0.067</td>
<td>0.796</td>
<td>0.067</td>
</tr>
<tr>
<td>F4</td>
<td>4.571</td>
<td>0.033</td>
<td>1.667</td>
<td>0.197</td>
<td>1.143</td>
</tr>
<tr>
<td>C3</td>
<td>0.286</td>
<td>0.593</td>
<td>0.067</td>
<td>0.796</td>
<td>0.067</td>
</tr>
<tr>
<td>Cz</td>
<td>1.143</td>
<td>0.285</td>
<td>0.077</td>
<td>0.782</td>
<td>0.286</td>
</tr>
<tr>
<td>C4</td>
<td>2.571</td>
<td>0.109</td>
<td>0.600</td>
<td>0.439</td>
<td>1.667</td>
</tr>
<tr>
<td>P3</td>
<td>0.000</td>
<td>1.000</td>
<td>0.600</td>
<td>0.439</td>
<td>0.600</td>
</tr>
<tr>
<td>Pz</td>
<td>0.286</td>
<td>0.593</td>
<td>1.143</td>
<td>0.285</td>
<td>0.286</td>
</tr>
<tr>
<td>P4</td>
<td>0.286</td>
<td>0.593</td>
<td>0.000</td>
<td>1.000</td>
<td>0.067</td>
</tr>
</tbody>
</table>
Table 5. A slightly more complex table with a caption that is the same width as the table. Simply place the caption inside a row at the top of the table and merge (combine) the cells together so that you have a single table cell the width of the table (select the row to contain the caption and do Table → Merge Cells). Justify the caption.

<table>
<thead>
<tr>
<th></th>
<th>Wake Chi Sq. ((N=15, df=1))</th>
<th>(p)</th>
<th>Stage 1 Chi Sq. ((N=15, df=1))</th>
<th>(p)</th>
<th>Stage 2 Chi Sq. ((N=15, df=1))</th>
<th>(p)</th>
</tr>
</thead>
<tbody>
<tr>
<td>F3</td>
<td>1.143</td>
<td>0.285</td>
<td>0.286</td>
<td>0.593</td>
<td>0.286</td>
<td>0.593</td>
</tr>
<tr>
<td>Fz</td>
<td>1.143</td>
<td>0.285</td>
<td>0.067</td>
<td>0.796</td>
<td>0.067</td>
<td>0.796</td>
</tr>
<tr>
<td>F4</td>
<td>4.571</td>
<td>0.033</td>
<td>1.667</td>
<td>0.197</td>
<td>1.143</td>
<td>0.285</td>
</tr>
<tr>
<td>C3</td>
<td>0.286</td>
<td>0.593</td>
<td>0.067</td>
<td>0.796</td>
<td>0.067</td>
<td>0.796</td>
</tr>
<tr>
<td>Cz</td>
<td>1.143</td>
<td>0.285</td>
<td>0.077</td>
<td>0.782</td>
<td>0.286</td>
<td>0.593</td>
</tr>
<tr>
<td>C4</td>
<td>2.571</td>
<td>0.109</td>
<td>0.600</td>
<td>0.439</td>
<td>1.667</td>
<td>0.197</td>
</tr>
<tr>
<td>P3</td>
<td>0.000</td>
<td>1.000</td>
<td>0.600</td>
<td>0.439</td>
<td>0.600</td>
<td>0.439</td>
</tr>
<tr>
<td>Pz</td>
<td>0.286</td>
<td>0.593</td>
<td>1.143</td>
<td>0.285</td>
<td>0.286</td>
<td>0.593</td>
</tr>
<tr>
<td>P4</td>
<td>0.286</td>
<td>0.593</td>
<td>0.000</td>
<td>1.000</td>
<td>0.067</td>
<td>0.796</td>
</tr>
</tbody>
</table>

7.6. Notes to tables
If you wish to format a table so that it contains notes (table footnotes) to the entries within the body of the table and/or within the table caption, these notes should be formatted using alphabetic superscripts such as \(a\), \(b\), \(c\) and so forth. Notes within the table caption should be listed first. Notes should be placed at the bottom of the table; one convenient method is to create an empty row at the bottom of the table to contain them. Again, merge the cells to give you a single cell the width of the table. Table notes should be 10 point Times Roman. Each note should be on a separate line.

Table 6. A table with headings spanning two columns and containing notes\(^a\).

<table>
<thead>
<tr>
<th>Nucleus</th>
<th>Thickness ((mg \text{ cm}^{-2}))</th>
<th>Composition</th>
<th>Separation energies</th>
<th>(\gamma), (n) (MeV)</th>
<th>(\gamma), (2n) (MeV)</th>
</tr>
</thead>
<tbody>
<tr>
<td>(^{183})Ta</td>
<td>19.3±0.1(^b)</td>
<td>Natural</td>
<td>7.6</td>
<td>14.2</td>
<td></td>
</tr>
<tr>
<td>(^{208})Pb</td>
<td>3.8±0.8(^c)</td>
<td>99% enriched</td>
<td>7.4</td>
<td>14.1</td>
<td></td>
</tr>
<tr>
<td>(^{209})Bi</td>
<td>2.6±0.01(^c)</td>
<td>Natural</td>
<td>7.5</td>
<td>14.4</td>
<td></td>
</tr>
</tbody>
</table>

\(^a\) Notes are referenced using alpha superscripts.

\(^b\) Self-supporting.

\(^c\) Deposited over Al backing.

8. Equations and mathematics

8.1. Fonts in Equation Editor (or MathType)
Make sure that your Equation Editor or MathType fonts, including sizes, are set up to match the text of your document.

8.2. Points of style

8.2.1. Vectors. Bold italic characters is our preferred style but the author may use any standard notation; for example, any of these styles for vectors is acceptable:

‘the vector cross product of \(a\) and \(b\) is given by \(a \times b \ldots\), or
‘the vector cross product of \(a\) and \(b\) is given by \(a \times b \ldots\), or
8.2.2. The solidus (‘\(\mid\)’). A two-line solidus should be avoided where possible; for example, use

- \(\frac{1}{M_0} \left( \int_0^\infty d\omega |S_0|^2 \right)^{-1}\) instead of \(\frac{1}{M_0/\int_0^\infty d\omega |S|^2}\)

- \(\left( \frac{x^2 + y^2}{x+y} \right)^{1/2}\) instead of \(\sqrt{\frac{x^2 + y^2}{x+y}}\).

8.2.3. Roman and italic in mathematics. Variables should be in italic; however there are some cases where it is better to use a Roman font:

- Use a Roman \(d\) for a differential \(d\), for example, \(\tan \theta = dy/dx\).
- Use a Roman \(e\) for an exponential \(e\); for example, \(y = e^x\).
- Use a Roman \(i\) for the square root of \(-1\); e.g., \(i = \sqrt{-1}\).
- Certain other common mathematical functions, such as \(\cos\), \(\sin\), \(\det\) and \(\ker\), should appear in Roman type.
- Subscripts and superscripts should be in Roman type if they are labels rather than variables or characters that take values. For example in the equation

\[ \varepsilon_m = -g \mu_n B_m \]

\(m\), the \(z\) component of the nuclear spin, is italic because it can have different values whereas \(n\) is Roman because it is a label meaning nuclear.

8.3. Alignment of mathematics
The preferred style for displayed mathematics in *Towards a Sustainable Built Environment: SBE16 Malta Conference* is to centre equations; however, long equations that will not fit on one line, or need to be continued on subsequent lines, should start flush left. Any continuation lines in such equations should be indented by 25 mm.

Equations should be split at mathematically sound points, often immediately before =, + or – signs or between terms multiplied together. The connecting signs are not repeated and appear only at the beginning of the turned-over line. A multiplication sign should be added to the start of turned-over lines where the break is between two multiplied terms.

8.3.1. Small displayed equations: Some examples:

\[ \phi_n (r) = (2\pi)^{3/2} \exp \left( i \mathbf{k} \cdot \mathbf{r} \right) \]  \hspace{1cm} (1)

\[ A^{(+) - A^{-}} (I = \frac{1}{2}) \]  \hspace{1cm} (2)

\[ C(12) = \left[ \hat{x} (x) \cdot \phi (x + r) \right] \]

\[ = 1 - \text{const} \frac{L^2}{\frac{\xi_1}{x^2}} \]  \hspace{1cm} (3)

\[ = 1 - \text{const} \frac{L^2}{\ln \left( \frac{L}{r} \right)} \]  \hspace{1cm} (3)

However, if equations will fit on one line, do so; for example, (5) may also be formatted as:
\[ C(12) = \left[ \hat{\mathcal{P}}(x) \cdot \hat{\phi}(x + r) \right] = 1 - \text{const} \frac{r^2}{L^2} \int x^2 \, dx + \cdots = 1 - \text{const} \frac{r^2}{L^2} \ln \left( \frac{L}{r} \right) + \cdots \] \quad (6)

8.3.2. Large display equations: examples. If an equation is almost the width of a line, place it flush left against the margin to allow room for the equation number.

\[ Y(h\nu) = \frac{1}{q} \frac{(h\nu)^2}{[(h\nu)^2 - v^2]^2 + (h\Delta \nu, \nu)^2} \int_{E}^{E + (E - h\nu)} \frac{E}{[E + (E - h\nu)]^{1/2} \exp[(E - E_{\nu})/kT] + 1} \, dE \] \quad (7)

\[ \sqrt{\frac{\hbar}{\beta}} \begin{cases} \cos \theta(\varphi) \cos \frac{\sqrt{\hbar n \varphi}}{1 - q} \\ \sin \theta(\varphi) \sin \frac{\sqrt{\hbar n \varphi}}{1 - q} \end{cases} \] \begin{align*}
&= \pm \frac{1 - q}{\sqrt{\hbar n \varphi}} \begin{cases} \cos \theta(\varphi) \sin \frac{\sqrt{\hbar n \varphi}}{1 - q} \\ \cos \theta(\varphi) \sin \frac{\sqrt{\hbar n \varphi}}{1 - q} \end{cases} + \frac{(1 - q)^2}{\hbar n^2} \cos \theta(\varphi) \sin \frac{\sqrt{\hbar n \varphi}}{1 - q} \sin \theta(\varphi) \cos \frac{\sqrt{\hbar n \varphi}}{1 - q} \\
&+ \hbar \frac{(1 - q)}{\hbar n^2} \int_{\varphi_{\beta}}^{\varphi_{\beta}} \begin{cases} \cos \theta(\varphi) \cos \frac{\sqrt{\hbar n \varphi}}{1 - q} \\ \sin \theta(\varphi) \sin \frac{\sqrt{\hbar n \varphi}}{1 - q} \end{cases} \, d\varphi. \end{align*} \quad (8)

8.4. Miscellaneous points

- Exponential expressions, especially those containing subscripts or superscripts, are clearer if the notation \( e^{\ldots} \) is used, except for simple examples. For instance, \( e^{i(kx - \omega \tau)} \) and \( e^{z^2} \) are preferred to \( \exp(i(kx - \omega \tau)) \) and \( \exp(z^2) \), but \( e^z \) is acceptable. Similarly the square root sign \( \sqrt{\ldots} \) should only be used with relatively simple expressions, e.g. \( \sqrt{2} \) and \( \sqrt{a^2 + b^2} \), but in other cases the power \( 1/2 \) should be used.
- It is important to distinguish between \( \ln = \log_e \) and \( \lg = \log_{10} \).
- Braces, brackets and parentheses should be used in the following order: \{[()]\}. The same ordering of brackets should be used within each size. However, this ordering can be ignored if the brackets have a special meaning (e.g. if they denote an average or a function).
- Decimal fractions should always be preceded by a zero: for example 0.123 not .123 (note, do not use commas, use the decimal point).
- Equations that are referred to in the text should be numbered with the number on the right-hand side.

8.5. Equation numbering

Equations may be numbered sequentially throughout the text (i.e., (1), (2), (3),...) or numbered by section (i.e., (1.1), (1.2), (2.1),...)) depending on the author’s personal preference. In articles with several appendices equation numbering by section is useful in the appendices even when sequential numbering has been used throughout the main body of the text: for example, A.1, A.2 and so forth. When referring to an equation in the text, always put the equation number in brackets—e.g. ‘as in equation (2)’ or ‘as in equation (2.1)’—and always spell out the word ‘equation’ in full, e.g. ‘if equation (5) is factorized’; do not use abbreviations such as ‘eqn.’ or ‘eq.’.

9. Appendices
Technical detail that it is necessary to include, but that interrupts the flow of the article, may be consigned to an appendix. Any appendices should be included at the end of the main text of the paper, after the acknowledgments section (if any) but before the reference list. If there are two or more appendices they should be called appendix A, appendix B, etc.

Numbered equations should be in the form (A.1), (A.2), etc, figures should appear as figure A1, figure B1, etc and tables as table A1, table B1, etc.

10. References
It is vitally important for all the references to be accurate and to be carefully formatted using the guidelines below, enabling your paper to be available online with the minimum of delay.

A complete reference should provide the reader with enough information to locate the article concerned, whether published in print or electronic form, and should, depending on the type of reference, consist of:

- name(s) and initials;
- date published;
- title of journal, book or other publication;
- titles of journal articles may also be included (optional);
- volume number;
- editors, if any;
- town of publication and publisher in parentheses for books;
- the page numbers.

Two different styles of referencing are in common use: the Harvard alphabetical system and the Vancouver numerical system. For Towards a Sustainable Built Environment: SBE16 Malta Conference, please use the Vancouver numerical system as described below.

10.1. Numerical system
In the numerical system references are numbered sequentially throughout the text. The numbers occur within square brackets, like this [2], and one number can be used to designate several references. The reference list gives the references in numerical, not alphabetical, order.

10.1.1. References to printed journal articles. A normal reference to a journal article contains three changes of font (see table 6).

Points to note
- There should be a 5 mm gap between the reference number (e.g., [8]) and the start of the reference text. Second and subsequent lines of individual references should be indented by 5 mm. For example:


- the authors should be in the form surname (with only the first letter capitalized) followed by the initials with no periods after the initials. Authors should be separated by a comma except for the last two which should be separated by ‘and’ with no comma preceding it.
- The article title should be in lower case letters, except for an initial capital, and should follow the date.
• The journal title is in italic and is abbreviated. If a journal has several parts denoted by different letters the part letter should be inserted after the journal in Roman type, e.g. Phys. Rev. A.

• Both the initial and final page numbers should be given where possible. The final page number should be in the shortest possible form and separated from the initial page number by an en rule ‘–’, e.g. 1203–14, i.e. the numbers ‘12’ are not repeated.

Table 6. Font styles for a reference to a journal article.

<table>
<thead>
<tr>
<th>Element</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authors</td>
<td>Roman type</td>
</tr>
<tr>
<td>Date</td>
<td>Roman type</td>
</tr>
<tr>
<td>Article title</td>
<td>Roman type</td>
</tr>
<tr>
<td>Journal title</td>
<td>Italic type</td>
</tr>
<tr>
<td>Volume number</td>
<td>Bold type</td>
</tr>
<tr>
<td>Page numbers</td>
<td>Roman type</td>
</tr>
</tbody>
</table>

Here are some examples taken from published papers:


OR


10.2. Reference lists
Up to ten authors may be given in a particular reference; where there are more than ten only the first should be given followed by et al.

Unpublished conferences and reports should generally not be included in the reference list and articles in the course of publication should be entered only if the journal of publication is known. A thesis submitted for a higher degree may be included in the reference list if it has not been superseded by a published paper and is available through a library; sufficient information should be given for it to be traced readily.

11. Cross referencing

• References. References should be cited in the text using square brackets; for example, ‘[3]’.

• Figures. Figures should be referenced in the text as ‘figure 1’, ‘figure 2’ etc.

• Tables. Tables should be referenced as ‘table 1’, ‘table 2’ etc.

• Sections, subsections and subsubsections. For example ‘section 3.1’ not ‘sec. 3.1’.

• Equations. Equations references should contain the equation number in parentheses, such as (3.1). Note that it is not normally necessary to include the word ‘equation’ before an equation number except where the number starts a sentence. The word ‘equation’ should not be abbreviated.

Acknowledgments
Authors wishing to acknowledge assistance or encouragement from colleagues, special work by technical staff or financial support from organizations should do so in an unnumbered Acknowledgments section immediately following the last numbered section of the paper.

Appendix A. Inserting footnotes with Microsoft Word
Suppose you need to format an author list as follows:

A Smith\textsuperscript{1,4}, J E Black\textsuperscript{2,5} and S T Mood\textsuperscript{3,6}

where superscripts 1, 2 and 3 refer to addresses and superscripts 4 and 5 are to provide further information, via footnotes, such as to indicate the corresponding author (4) and details of research funding (5). So, we need to have the first footnote as number 4. Fortunately, Word allows you to set the number at which footnotes start.

From the Insert menu option, select Reference (or the equivalent option if you are not using Word XP) to display a dialog box that controls the insertion of footnotes and endnotes:

![Footnote and Endnote dialog box](image)

Because we need the first footnote to start at 4, type ‘4’ in the ‘Start at:’ text box as shown above. Click Apply to restart the numbering.